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Carbohydrates

About this Lesson:

Carbohydrates are one of the most important organic molecules found in living
organisms and come in many different forms and sizes. This lesson will introduce the
role of carbohydrates in living systems and will cover the carbohydrate taxonomy,
including monosaccharides, disaccharides, oligosaccharides, and polysaccharides.

Using Maestro, students will learn how to use the 2D sketcher to build simple
carbohydrate molecules, visualize the shapes of simple sugars, and build and compare

the structures of cellulose and starch in the Maestro graphical interface.

Learning Objectives:

e Define the term carbohydrate and explain its importance in living organisms

e Describe the carbohydrate taxonomy and identify examples of monosaccharides,
disaccharides, and polysaccharides

e Examine simple carbohydrate structures in different 2D and 3D representations

e Build and compare complex carbohydrate structures using the Polymer Builder

Lesson Contents:

1. Setting Up the Maestro Session
Introduction to Carbohydrates
Carbohydrate Taxonomy
Types and Properties of Polysaccharides
Molecular Visualization of Carbohydrates
Individual Exercise

Summary, Additional Resources, and References
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Standards Alignment: Assessments for Understanding:

o AAMC MCAT The following types of formative assessments are
o Biological and Biochemical = embedded in this lesson:

Foundations of Living
Systems (1D)
e IBDP Chemistry
o Biochemistry -

e Assessment of student understanding
through discussion of warm-up questions
and filling in any knowledge gaps about the
different types and properties of

Carbohydrates (B4) carbohydrates
e |BDP Biology
o Carbohydrates and Lipids e Visual assessment of student-generated
(2.3) simple sugars and complex carbohydrates

Associated Documentation Pages: Building a Carbohydrate Polymer

Warm-Up Questions:

Read the Khan Academy article on Carbohydrates and answer the following questions:

1) How does our body get energy from complex carbohydrates?

2) What are the two main functions of polysaccharides?

Need help? Contact us at teaching@schrodinger.com
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1. Setting Up the Maestro Session

At the start of the Maestro session, it is essential to 1) check your mouse actions, 2) change

the file path to the Working Directory for this lesson, and 3) save your project file. The

working directory indicated in this section contains the files necessary to complete this

lesson. If you do not set the appropriate working directory, you will be unable to run any

calculations.

[@ Schrodinger

VIRTUAL
WORKSTATION

Password

By clicking Login, you agree to use the Schrédinger
Virtual Cluster in accordance with
the Schrodinger End User License Agreement.

Figure 1-1. Virtual workstation login page.

-

Figure 1-2. Course-data folder on the desktop.

1. Launch the Virtual Cluster

2. Double-click the course-data folder
on the desktop
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Een 3. Right-click the Carbohydrates

| openinNew Tab folder and select Copy to > Desktop
Open in New Window

Open With Other Application...
ge Cut
[ Copy

Make Link

> other pane
» 5] Home Folder

(o) Desktop

Figure 1-3. Copy the lesson folder to the
Desktop.

& Move to Trash

4. Double-click the Maestro icon on
the desktop

] ] Customize Mouse Actions
‘Customize actions for: uttons and scrol eel .,‘
No Modifiers Shift Cmd Shift+Cmd 5 C h k t‘
— . €CK your mouse actions.
Button 2 Rotate (& spot center) X or Y rotate (gesture-based) Z rotate Zoom
Button 3 Translate X or Y translate (gesture-.  Z translate G t W k
B e} o (o OrKspace >
Button 263 Zo0m H M A t'
e Customize Mouse Actions
Swap buttons: 1&2 183 2&3 Reset Defaults

o Note: This lesson was made

with a three-button mouse
with a scroll wheel, but a
trackpad can still be used
o Trackpad keys:
=  Up/Down trackpad =
Zoom In/Out

Figure 1-4. Change the mouse actions.

m Option = Rotate
m Control = Translate
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FIE] Edit Select Workspace Scripts View Window
New Project... Ctrl+N

6. Go to File > Change Working

Open Project... Ctrl+0 Directory

Open Recent Project »
Save Project As... Ctrl+Shift+5
Close Project Ctri+w

Import Structures... Ctri+l

Import Recent Structures 4
Import From .
Merge Project...

Get PDB...

Export Structures...

Export to LiveDesign...

Change Working Directory...

Back Up Project...

Restore From Backup...

Save Checkpoint

Quit Ctrl+Q

Figure 1-5. Change Working Directory option.

@ Change Directory x|
Look in: | [ ] /homej/user975/Desktop v |& EE 7. Navigate to Desktop >
pe

Hamel;rectory course-data CarbOhydI‘ateS folder and C“Ck

course-data (copy)

\\ diels-alder.prj Choose

Custom Directory

j

Working Directory

| Pre-generated input and results files are
included for running jobs or examining

Directory:  |Carbohydrates output
Files of type: | Directories - Cancel

Figure 1-6. Change Working Directory panel.
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Save Project As...

Ctrl+Shift+S

Close Project

Import Structures...

Ctri+w

Ctrl+I

Back to Lesson Contents

8. Go to File > Save Project As

Import Recent Structures b
Import From »
Merge Project...

Get PDB...

Export Structures...

Export to LiveDesign...

Change Working Directory...

Back Up Project...

Restore From Backup...

Save Checkpoint

Quit Ctrl+Q

Figure 1-7. Save Project option.

© Ssave Project x|

Look in: /home/user975/Desktop/Carbohydrates v |&

A

SR carbohydrates_lesson, click Save

N o

Custom Directory

Working Directory

9. Change the File name to

The project is now named
carbohydrates_lesson.prj

Save as: | Maestro project - v/ Open now Help
File name:  |carbohyrates_lesson | | sae |
Files of type: | Maestro Projects (*.prj) ~ | Cancel

Figure 1-8. Save Project panel.
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2. Introduction to Carbohydrates

When you first think of the word carbohydrates, chances are you thought of food! Potatoes,
rice, and pasta are all rich sources of carbohydrates and happen to be a part of our daily
diet. Along with proteins and fats, carbohydrates are one of three main nutrients found in
our food and drinks and they play a vital role in the human body. Carbohydrates provide
the body with glucose, a source of quick, short-term energy that is used to support various
bodily functions and physical activity. Glucose can be used immediately by the body or it
can be stored in the liver and muscles for later use.

Let's begin our discussion of carbohydrates by examining the elements from which
carbohydrates are built. If we look at the name, carbohydrate, we can break it down to two
parts: carbo- and hydrate-. The carbo- part tells us that the element carbon is a main
component in the structure of carbohydrates. The hydrate- part means water and
originates from the Greek language. Water, as we all know, is composed of hydrogen and
oxygen atoms. Hence, carbohydrates are composed of carbon, hydrogen, and oxygen
atoms, and are what we call, biological macromolecules. While there are many different
types of carbohydrates, they all have the generic formula C(H,0),.

Carbohydrates

Disaccharides

Monosaccharides Oligosaccharides

Polysaccharides

—= &
e B
—= &)

Maltose

Raffinose

Stachyose

Galactose Lactose

m
000

Figure 2-1. Carbohydrate taxonomy chart
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3. Carbohydrate Taxonomy

Let's continue our exploration of carbohydrates. As you can see from Figure 2-1,
carbohydrates exist in many different shapes and sizes. They can exist as simple sugars,
such as monosaccharides and disaccharides, or they can exist in more complex forms,
like oligosaccharides and polysaccharides.

3.1. Monosaccharides

Monosaccharides are carbohydrates composed of one type of sugar. Monosaccharides
have a formula of (CH,0), and typically contain three to seven carbon atoms. Most of the
oxygen atoms found in monosaccharides are in hydroxyl (OH) groups, but one of them is
part of a carbonyl group (C=0). The position of the carbonyl group can be used to
categorize the monosaccharides: if the monosaccharide has an aldehyde group (R-CH=0),
the sugar is known as an aldose; if the monosaccharide has a ketone (R-C=0-R), the sugar
is known as an ketose.

Apart from glucose, other monosaccharides include fructose and galactose. Fructose is
the natural sugar found in fruits, while galactose can be found in abundance in dairy
products. What's interesting is that glucose, fructose, and galactose are all isomers. This
means that they all have the same chemical formula, but the way the atoms are arranged
in each carbohydrate differ. Figure 3-1 illustrates the structures of glucose, fructose, and
galactose in a side-by-side comparison.

Glucose Fructose Galactose
CHO CH,0H CHO
H————OH c—o H————OH
HO————H HO————H HO————H
H——1——0OH H—————O0H HO—————H
H————0H H———F——O0H H————OH
CH,0H CHOH CHo0H
CH;0H CH,OH
° o
O CH,OH OH
OH
CH,0H
OH\ OH OH o OH OH

OH
O OH

Figure 3-1. Structures of glucose, fructose and galactose
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Practice #1. Look closely at Figure 3-1. Circle the aldehyde and ketone groups in
each carbohydrate, Categorize glucose, fructose, and galactose as an aldose or
ketose,

Figure 3-1 does not paint a complete picture. This is because glucose is a monosaccharide
that can exist in two main forms: D-glucose (or dextrose) and L-glucose. D-glucose and
L-glucose are enantiomers, which means that their molecular structures are mirror
images of each other. The key difference is that in D-glucose, three hydroxyl groups and
one hydrogen group are on the right side whereas in L-glucose, the three hydroxyl groups
and one hydrogen group are on the left side.

Practice #2. s the glucose structure in Figure 3-1 in D- form or
L-form?

Unlike L-glucose, D-glucose occurs more widely in nature and is thus one of the most
important aldohexose sugars found in living organisms. D-glucose contains two further
isomers: alpha-D-glucose and beta-D-glucose. The key difference between alpha (a) and
beta (B) D-glucose is the orientation of the hydroxyl groups attached to the first and fourth
carbon atoms. Alpha-D-glucose has hydroxyl groups in the 1 and 4 positions on the same
side. Beta-D-glucose has hydroxyl groups in the 1 and 4 positions on opposite sides. Figure
3-2 demonstrates this configuration.
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,CH,OH

D-glucose (linear form)

B-D-glucose

Figure 3. Molecular structures of alpha-D-glucose and beta-D-glucose
3.2. Disaccharides

A disaccharide is a carbohydrate formed when two monosaccharides are joined together
via a condensation reaction (also known as a dehydration reaction). In this process, the
hydroxyl group of one monosaccharide combines with the hydrogen of another, releasing a
water molecule in the process and forming a covalent bond called a glycosidic linkage.
The reaction that takes place between two monosaccharides is demonstrated in Figure 3-3.
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CH,OH
(0]
o) CH,OH
o] CH,OH
OH\ OH OH ol
Glucose OH Fructose OH
CH,OH
(0]
e}
CH,OH
(@] OH
(@)
Glycosidic linkage

Sucrose

OH

OH

Figure 3-3. Condensation reaction between glucose and fructose to form sucrose.

3.3. Oligosaccharides

Oligosaccharides and polysaccharides are both made up of monosaccharides. The main
difference between the two is that oligosaccharides are made out of a fewer number of
monosaccharides whereas polysaccharides are made out of a larger number of
monosaccharides. A number of oligosaccharides can also form multiple linkages to
produce a polysaccharide. Cellulose, starch, and glycogen are well-known examples of
polysaccharides. These complex macromolecules are an important source of energy in
animal cells, and form a structural component of a plant cell.
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Polysaccharides can either be a straight chain of monosaccharides known as linear

polysaccharides, or they can also form branches known as a branched polysaccharide.

Figure 3-4 depicts the structures of cellulose, amylose, amylopectin, and glycogen.

Cellulose

Starch

Amylose

Amylopectin

Glycogen

Shape
H
OH HOt,
HO.\ OH
0 H"__'(\ oH
CH,0H CH,OH o i
e OH 0 0. : OHO HO ng:m
0 HO OH OH U Forl ™ |
Structure HO O o < O -
OH OH 0 HO Q OH Y
HO! N—{\_- "o
OH OH OH s o ,1 |
%0 j° o <
Hol .. iy
0 "o fho i

Figure 3-4. Shape and structure of different types of polysaccharides.

Practice #3. Take a close examination at Figure 3-4. Which polysaccharide(s) would you

categorize as linear? Which one(s) would you categorize as branched?

4. Types and Properties of Polysaccharides

In Section 3, we examined the carbohydrate taxonomy and dived deep into examples from

each taxonomic group. We also learned that polysaccharides are an important source of

energy and structure for animal and plant cells, and we looked at three main examples:

cellulose, starch, and glycogen.

4.1. Types of polysaccharides
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Each of the polysaccharides mentioned above are composed of glucose subunits, and can
be referred to as homopolysaccharides. A homopolysaccharide is a polysaccharide
composed of only one type of monosaccharide. A heteropolysaccharide on the other
hand, is a polysaccharide composed of different types of monosaccharides. One example is
hyaluronic acid, which is made up of the monosaccharides D-glucuronic acid and
N-acetyl-glucosamine, and is a natural substance found in our connective tissues and skin.
Hyaluronic acid is also a glycosaminoglycan (or GAG), a negatively charged polysaccharide
that is made up of repeating disaccharide units. The structure of hyaluronic acid is
displayed in Figure 4-1.

COOH G0k N
(@]
H /
O\\
OH H /' H
(lj
G-glucuronic acid N-acetyl glycosamine
= n

Figure 4-1. The repeating disaccharide unit of hyaluronic acid.

Practice #4. Recall from Section 2 that all carbohydrates are made up of carbon, hydrogen,
and oxygen atoms. From Figure 4-1, what do you notice that is different about the structure
of N-acetyl glucosamine? Elaborate below.
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4.2. Properties of polysaccharides

Polysaccharides, as you already know, are macromolecules composed of a large number of
monosaccharides. They thus have a high molecular weight. The molecular weight of
polysaccharides can reach as high as 100,000 daltons or more if enough monosaccharides
are joined together. This makes polysaccharides very large, complex molecules that are
hydrophobic and unable to diffuse through cell membranes. They can pass through
membranes only when broken down into their component monomers, i.e. simple sugars.
Similarly, polysaccharides are also not sweet in taste. However, enzymes such as amylase
can break down polysaccharides like amylose, into their glucose subunits, which do in fact
taste sweet.

5. Molecular Visualization of Carbohydrates

In this activity, you will learn how to build simple monosaccharide units in Maestro, as well
as compare the structures of two different polysaccharides using the graphical user

interface.

Computational Exercise #1: Building carbohydrate biopolymers

This exercise involves three parts:
1) Build a D-glucose molecule using the 2D sketcher
2) Translate the 3D glucose structure to a 2D Fischer projection
3) Build and compare the structures of cellulose and amylose
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Figure 5-1. Open 2D Sketcher.
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Figure 5-2. Drawing D-glucose.
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Part 1. Building D-glucose

In Part 1, you will learn how to draw a
‘zigzag' structure of D-glucose using the 2D
sketcher. A zigzag structure (or Natta
projection) is a way of representing
three-dimensional molecules in which the
carbon skeleton is drawn in a continuous
“w" shape (hence the name zigzag
structure), and the stereochemistry at each
carbon is denoted with wedges and
dashes.

Learn More: Take a look at our lesson on
Stereoisomers to learn more about the
three-dimensional, spatial arrangement of
atoms and molecules!

1. Go to Edit > 2D Sketcher. If any
existing structures are still in the 2D
Sketcher workspace, use the eraser
to delete the structure.

2. Draw the zigzag structure of
D-glucose exactly how it is shown in

Figure 5-2
o Gotothe Draw Tools on the
left

o Create the carbon skeleton
by choosing the C atom and
clicking in the 2D workspace.

o A methyl group appears

ts
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o Drag rightwards from the
methyl group to draw a
carbon skeleton consisting of
seven bond lines

o Add an OH group to the
leftmost tail end of the
skeleton by selecting the O
atom from Draw Tools and
clicking on the end of the
bond line

o Add an aldehyde group to
the rightmost tail end of the
skeleton by changing the last
bond line to a double bond
and adding an O atom to the
end of the bond line

o Create a wedge bond on the
second carbon from the left
by choosing the wedge bond
and dragging up from the
carbon atom

o Add an OH group to the
wedge by selecting the O
atom from Draw Tools and
clicking on the end of the
wedge bond

o Create a dashed bond on the
third carbon atom from the
left by choosing the dashed
bond and dragging down
from the carbon atom

o Add an OH group to the
dashed bond by selecting the
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O atom from Draw Tools and
clicking on the end of the
dashed bond

o Repeat the steps for creating
a dashed bond with an OH
group for carbon atoms 4
and 5 as shown in Figure 5-2

3. Click on Save as New and for Input
Entry Title write D-glucose.
e 4. Click OK.

c H N
o P s OH OH

@ Entry Title x

F oc si o :
Input Entry Title

B
A g, & 7N D-glucose

He 5 4
s PP,
AN
000
000
oA

OE

Editing project entry: (no entry)

Figure 5-3. Saving D-glucose.

Pause & Think #1: How many chiral carbons does a D-glucose molecule
have? Identify the positions of each chiral carbon and list them below.
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Pause & Think #2: Take a screenshot of your D-glucose structure in the 3D workspace
and paste it below. What do you notice about the directions of each OH group?

Pause & Think #3: Based on your observation in Question 2, what conclusions
can you draw about wedged and dashed bonds
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Part 2. Translating a 3D structure to a 2D Fisher projection

Sugars can be drawn in the straight chain form as either Fischer projections or as zigzag
formulas that organic chemists often prefer. When drawing Fischer projections, the
aldehyde group is written at the top, and the H and OH groups that are attached to each
chiral carbon are written to the right or left. The arrangement of the atoms distinguishes
one stereoisomer from the other.

Pause & Think #4: Using the 3D structure of D-glucose you generated using the 2D
sketcher and 30 workspace, sketch a Fischer projection of the same molecule in the space
below.

Question #5: What is one advantage of Fischer projections over
zigzag structures of organic molecules?
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Polymer Builder

Groups | Composition | Chain Growth

Monomer type: )All-atom () Coarse-grainedl'® Carbohydrate [l Ladder

End groups

Initiator: | Sketch... | [H B H Name: H

Terminator: Sketch... hydroxyl @ HO Name:  hydroxyl

Monomers

Add Monomer

A |alpha-D-Glucose B C6H1005 Name: |alpha-D-Glucose o
Color by: | Element ~ | Ball and Stick: | None ~ | Tube: | None

Total atoms per chain: 213 Molecular weight: 1639.45
Title: |w-hydroxylpoly (alpha-D-Glucose)

Job name: [amylose 12mer |8~ Run

(ST ST ®

Figure 5-4. Polymer Builder panel with the
Carbohydrate default parameters.
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Part 3. Build and compare the structures

of cellulose and amylose

5.

9.

Go to Tasks > Structure Builders >
Polymer
For Monomer type select
Carbohydrate
o The panel updates to the
specialized carbohydrate
parameters
Leave End Groups as the default: H
For amylose, leave alpha-D-Glucose
as monomer A, which again is the
default.
Go to the Composition tab

Note: Hydroxyl is also available as an end

group selection, if needed. To see which

end of the monomer is the head versus the

tail, hover over the molecular formula and
the 2D Sketch will appear with R1 and R2
labeled for head and tail, respectively

@ Schrodinger Education

21

The recipient shall not use the Schrédinger software, materials and information other than for the purposes for which they were distributed. Schrédinger owns the software and all materials, and retains all related
intellectual property rights. Schrédinger will retain all intellectual property rights relating to any suggestions, ideas, enhancement requests, feedback, recommendations or other information provided by the
recipient or any third party. The recipient shall not use Schrédinger’s names or marks without Schrédinger’s prior written consent. THE SOFTWARE AND MATERIALS ARE PROVIDED "AS IS" WITHOUT WARRANTY OF
ANY KIND. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL SCHRODINGER OR ITS AFFILIATES OR LICENSORS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, CONSEQUENTIAL,

PUNITIVE OR EXEMPLARY DAMAGES.



Back to Lesson Contents

Polymer Builder

Groups | Composition | Chain Growth

~engine 4o 10. In the Composition tab, set the
number of monomers to 12

o We will construct a 12mer

o The Total atoms per chain:
and Molecular weight: update
accordingly

We do not need to change anything in the
Chain Growth tab.

Color by: | Element ~ | Ball and stick: | None ~ | Tube: [None
Total atoms per chain: 255 Molecular weight: 1963.74
Title: |w-hydroxylpoly (alpha-D-Glucose)

> — B - 11. Change the Job name: to

@ Host=localhost:1, Incorporate=Append new entries as a new group

Polymer Builder - Job Settings x . . .
Output 12. Adjust the job settings ( g ~)
Incorporate: | Append new entries as a new group ~ o Host: cpu-preemptible (400)
Job

Name: |amylose 12mer o Total: 4 processors

Host: | cpu-preemptible (400) ~ |Total: | 4| < | processors
Run | 0K Cancel Help

13. Click Run

o The job should be completed

Figure 5-5. Composition tab and running the within a few minutes.

job.
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14. Once the job is incorporated,
include poly(alpha-D-Glucose) in the
workspace

15. Go to the Style dropdown and
select Apply ball-and-stick
representation

16. For cellulose, repeat steps 1 to 10

Color Atoms

Element + ..tom Ligand N using the monomer beta-D-Glucose
instead
Apply Labels 17. Change the Job name: to

cellulose_12mer
surface o The job should be completed

within a few minutes.
Figure 5-6. Updating the style to 18

ball-and-stick. 19

. Close the Polymer Builder panel

. Once both jobs are incorporated,
include poly(alpha-D-Glucose) and
poly(beta-D-glucose) in the

89 Alternate Positions ) Coordinate Axes workspace

WORKSPACE TOGGLES

(] unit cel Polyhedrons 20. Go to the plus icon in the bottom
' Dipole Moment 11 Moments of Inertia rlght corner of the Maestro interface
WORKSPACE GADGETS and select Tile view

21. Play around with your mouse and

./ Clipping Planes E: Workspace Navigator ) .
scroll wheel to zoom in/out into the

I)’ 2D Overlay &= Workspace Properties
structures.

» _ Command Input Area B Sequence Viewer

WORKSPACE LAYOUT

nn : = COLOR:

Tile b Ent
@ (- Fo] 9@
A3 Stereo Font Size: |A™||a ™
Figure 5-7. Selecting Tile view.
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Pause & Think #6: Take a screenshot of your poly(alpha-D-Glucose) and
poly(beta-D-Glucose) structures side-by-side in the tile view. Paste your screenshot in the
table below, What similarities and differences do you observe between the two polymers?
Note them down in the table below.

Amylose and cellulose side-by-side screenshot:

Similarities Differences
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6. Individual Exercise

Recall from Section 3.1 of this lesson that apart from glucose, fructose is also another
well-known monosaccharide and is the natural sugar found in fruits. Fructose has the same
chemical formula as glucose, but the way the atoms are arranged in each carbohydrate
molecule differ.

1) Repeat steps 1- 4 of Part 1 of the computational exercise for a D-fructose molecule
instead. The zigzag structure of D-fructose is given below.

OH O

2) Take a screenshot of your D-fructose molecule in the 3D workspace and paste it
below.
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3) Take a screenshot of your D-fructose and D-glucose structures side-by-side in the
tile view. Paste your screenshot in the table below. What similarities and differences
do you observe between the two monomers?

D-fructose and D-glucose side-by-side screenshot:

Similarities Differences

1) Draw a Fischer projection of a D-fructose molecule.
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7. Summary, Additional Resources, and References

In this lesson, students learned how to use the 2D Sketcher and Polymer Builder to
construct simple and complex carbohydrates, as well as translate the 3D structures to 2D
representations. Using Maestro, students were able to interact with the carbohydrate
polymers using the graphical user interface to zoom in/out, as well as compare and
contrast each structure using Tile view.

For further learning:

e Introduction to Computational Chemistry, 3rd Edition
e Essentials of Computational Chemistry: Theories and Models, 2nd Edition

e See the Build Biopolymer help documentation

8. Glossary of Terms

Entry List - a simplified view of the Project Table that allows you to perform basic
operations such as selection and inclusion

Included - the entry is represented in the Workspace, the circle in the In column is blue

Project Table - displays the contents of a project and is also an interface for performing
operations on selected entries, viewing properties, and organizing structures and data

Recent actions - This is a list of your recent actions, which you can use to reopen a panel,
displayed below the Browse row. (Right-click to delete.)

Scratch Project - a temporary project in which work is not saved. Closing a scratch project
removes all current work and begins a new scratch project

Selected - (1) the atoms are chosen in the Workspace. These atoms are referred to as "the
selection" or "the atom selection". Workspace operations are performed on the selected
atoms. (2) The entry is chosen in the Entry List (and Project Table) and the row for the entry
is highlighted. Project operations are performed on all selected entries

Working Directory - the location that files are saved

Workspace - the 3D display area in the center of the main window, where molecular
structures are displayed
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Biological macromolecule - a large, organic molecule such as carbohydrates, lipids,
proteins, and nucleic acids

Monosaccharide - a carbohydrate composed of one type of sugar

Disaccharide - a carbohydrate formed when two monosaccharides are joined together via a
condensation reaction

Polysaccharide - a carbohydrate composed of a large number of monosaccharides

Glycosidic linkage - a type of covalent bond that joins a carbohydrate molecule to another
group, which may or may not be another carbohydrate
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